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Figure 1. The Merkato Login Screen 

Figure 2. The Opening Merkato Portal Screen 

Starting Merkato 

Before you start, be sure you have a username and password for Merkato. You will 
also need the URL (web address) of the Merkato portal. 

Note: Merkato has been tested on Internet Explorer version 6.0 and later versions. While 
Merkato may work on other browsers, we have not verified this. 

Logging In 

Point your browser to the Merkato portal. The opening page looks like the one in 
Figure 1. 

Enter your username and password and click Login. 

(If you need a username and password, contact your Merkato administrator.) 

When you successfully log in, the Merkato Agent screen appears, displaying the 
Express interface. (See Figure 2.)  

From this top-level agent page you can get to the desktop interface, the Wizard (see 
page 12), and the various screens that make up the Portal.  
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Figure 3. The Merkato Desktop 

Planning For Your Bandwidth Needs 

Before you buy bandwidth you should plan your bandwidth needs. 

A good way to determine your bandwidth needs is to calculate your data transfer rate requirements. 
Merkato specifies the rate in Kbps, Mbps, or Gbps. (See “Units Conversion Chart” on page 34.) 

Reserved or Spot-Market Bandwidth? 
There are two ways to purchase bandwidth in a Merkato system. 

•  You can create a bidding strategy and bid for bandwidth with other buyers, establishing a fair 
market price based on supply and demand. This is the Spot market. 

•  You can request and reserve a fixed amount of bandwidth, at a fixed price, for a fixed term. This is 
the Reservation market 

To get bandwidth from the Spot market, you configure your Merkato agent to bid on your behalf in a 
continuous bandwidth auction. To get bandwidth in the Reservation market you use your Merkato agent to 
ask for a fixed-price quote, based on the quantity and duration you specify. Bandwidth may be obtained on 
both markets simultaneously and combined into a single allocation. 

(For a complete description of each method, see Merkato Buyer’s User Manual, “Spot Market and 
Reservation Market Agents.”) 

Buying Reserved Bandwidth 
The Reservation agent allows you to obtain an allocation of bandwidth that begins and ends at dates and 
times you specify. 

Reservations must be bought on the Merkato desktop interface. To buy reserved bandwidth, perform the 
following procedures. 

Log in to the Merkato portal. (See “Logging In” on page 1.) 
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From the user interface pull-down menu in the browser window, select Desktop and click select. 

 

If the Java plug-in works correctly, you see a series of download messages and the Merkato Desktop 
window appears (Figure 3).  

Downloading the Desktop Agent 

The Desktop interface allows you to control your agent and observe the auction in progress. Your agent is 
brought to your PC and bids on your behalf from the Merkato desktop. 

Java on Your Browser 
If your browser is not configured for Java version 1.4.1 you must download it before you can run a 
Desktop agent. You can allow Merkato to do this automatically, or you can download it directly from the 
source whose link is provided in the login page. 

There are later versions of Java, but we do not recommend using them. 

Automatic Download 
If your browser doesn’t have Java version 1.4.1, the first time you attempt to download a Desktop agent 
you are guided through the installation of the Java plug-in. 

Reply “Yes” to all security permission requests. 

Active Download 
If you encounter problems, you can download Java free from Sun Microsystems. The URL is: 

http://java.sun.com/products/plugin/
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Figure 5. The Desktop Agent Download 
Window 

Figure 4. The Desktop Agent Download 
Menu 

Note: As of this writing, to get the plug-in, you must download the entire Java Run Time Environment, which is 
greater than 5 MB. Netscape version 6.1 for Windows appears to support the Merkato Java applications, 
but it is not fully tested for Merkato version 2.1.  Merkato supports all versions of Internet Explorer. 
Likewise, the Java 1.4.1 plug-in for Macintosh OS X appears to work as well, but is not fully tested for 
Merkato version 2.1. 

Download Procedure 
To download an agent follow these steps: 

1. In the Agent Download window (Figure 5) enter the username and password. 

By default, this is the same as the username and password you used to access the Desktop 
interface from the initial login; the fields are populated with this information. You may specify 
another valid username and password to download another agent. 

2. If the Agent Download window is not available, from the File pull-down menu (Figure 4), select 
Download Agent. 

The Agent Download window appears. 
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Figure 6: The Garage Selection 
Pull-Down Menu 

Figure 7. The Desktop Agent Window 

If there are Garage choices on a pull-down list that indicates both Spot and Reservation marketplaces, 
select reservation-garage and click Download. (See Figure 6.) 

If you have a single choice in the Garage field, your Merkato administrator will have given you two 
distinct usernames and passwords—one for each market. In this case, make sure that the username and 
password correspond to the Reservation market and click Download. 

 

 

 

 

The Desktop Agent window appears (Figure 7). This is the agent interface through which you make 
your reservation. 
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Figure 8. The Capacity Graph 

Figure 9. The Reservation Strategy Window 

Making the Reservation 

1. Connect to the marketplace by clicking on the Connect icon ( ). 

2. If the capacity graph is not visible, select Capacity Graph from Status pull-down menu. The 
Capacity graph appears. (See Figure 8.) The capacity graph shows the bandwidth capacity 
available to be reserved. The capacity available is shown as a yellow line on the graph. Existing 
reservations are shown in blue. Note that you can not make a reservation when there is no 
capacity. 

3. Click the Start icon ( ). 

4. Read the available bandwidth capacity from either the News or the Resource window. If this 
capacity is greater than or equal to what you want, proceed. (If not, you can either attempt to 
obtain what is available or consider buying bandwidth on the Spot market.) 

5. From the Strategy pull-down menu, select Reservation Strategy.  (See Figure 9.) Expand the 
display area, if necessary, to see the Reservation Strategy window at the bottom. 

6. Click the pack icon ( ) on the menu-bar or select Pack from the View pull-down 
menu. The agent window resizes itself to accommodate the windows you are currently 
displaying. 

7. In the Reservation Strategy window, make sure the Current Strategy button is 
selected. 

8. If the quantity (Mbps) or time units (month) do not suit your needs, you can change the 
units. Select Units from the Selection pull-down menu. The Units box lets you use 
Kbps, Mbps, or Gbps, as well as minutes, hours, days, or months, and dollars and cents. 
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Figure 10. The Reservation Strategy Window 

9. In the Start Time panel (see Figure 10), select when you want the reservation to begin. 
There are three choices for the start time of your reservation: 

•  Current Time: If you select Current Time, the reservation, if accepted, begins 
immediately. To select the present as a start time click the radio button on the left. 

•  Future time: If you want the reservation to start at a certain future time, enter the 
year, month, day, hour, and minute at which you want the reservation to start. You 
must make sure that the date is valid (not February 30th, for example). Should you 
inadvertently enter an invalid date, Merkato attempts to determine your intent and 
present an equivalent valid date. If this is not what you intended to specify, you will 
have the chance to refuse the reservation and return to the date selection window. To 
select a future start time click the radio button on the left. 

•  End time of a reservation: If you have already created one or more reservations, 
they appear in this pull-down list. You can select the end of one of these existing 
reservations as the start time of the new reservation you are making. Select it from 
the list and click the radio button on the left. 

10. In the End Time panel (see Figure 10), select when you want the reservation to end. 
There are two choices for the end time of your reservation: 

•  Future time: Enter the year, month, day, hour, and minute at which you want the 
reservation to end. You must make sure that the date is valid (not February 30th, for 
example). Should you inadvertently enter an invalid date, Merkato attempts to 
determine your intent and present an equivalent valid date. If this is not what you 
intended to specify, you will have the chance to refuse the reservation and return to the date 
selection window. 

•  Start time of a reservation: If you have already created one or more reservations, they 
appear in this pull-down list. You can select the start of one of these existing reservations as 
the end time of the new reservation you are making. Select it from the list and click the radio 
button on the left. 

11. Enter the amount of bandwidth you want in the Reservation portion of the box. 
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Figure 12. The Reservations Table 

Figure 11. The Reseration 
Confirmation Box 

12. If you are satisfied that the quantity and duration specified, click Get Quote. A confirmation box 
appears. (See Figure 11.) 

13. If the price and cancellation fee are acceptable, click Accept. Otherwise, click Refuse and revise 
your reservation request. 

Once you click Accept your reservation is activated. 

 

 

 

 

 

•  To review or cancel your reservation, select Reservations Table from 
the Status pull-down menu. The Reservation Table appears (Figure 
12). 

•  To cancel a reservation, select it from the Reservations Table and 
click Cancel Reservation. 
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Exiting Merkato 
To exit the Merkato desktop, click the close-box tab at the upper right hand corner of the window ( ), or 
select Exit Merkato from the File pull-down menu. 

Merkato gives you the option of uploading your agent when you close it on the desktop. If you upload 
your agent, the next time you download it the agent will retain the same units configuration. 

You can leave the portal page in the browser open to monitor your agent status or click Logout in the list 
on the left side of the window. 
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Buying Bandwidth on the Spot Market 

On the Spot market, bandwidth is distributed by a system that ranks bidders by the price they offer, but 
charges them based on the price offered by the highest bidder who bids too low to win an allocation of 
bandwidth.  If you bid too low in an auction you will be out-bid by other buyers. 

The bidding process can be automated and run continuously without your intervention.  

The Spot market lets you get allocations of bandwidth to be used immediately; it provides bandwidth-on-
demand. The changes you make to your agent’s bidding profile take effect immediately and a resulting 
allocation will be granted in less than five minutes at the close of the auction in progress. You may start 
or stop bidding at any time. 

Note: Bidding From the Garage or From the Desktop 
Although the auction allocation process runs continuously, there is no need for you to be 
directly involved at all times. Your agent can bid automatically for you after you configure it 
with figures indicating the value you place on bandwidth. Your agent and the seller’s agent 
interact on the Merkato server while their configurations are stored in the Garage.  

Once you configure your agent, you can either bid from your PC using a Java-based 
application, or communicate remotely with your agent as it bids from the Garage. 

Bidding from your PC and operating a remote agent each has advantages. On your PC, the 
Merkato desktop display gives you real-time information about the auction and its 
participants. If you are not interacting with the agent, you can configure it and upload it to 
the Garage. It will continue to run, and you avoid the chance of ceasing to bid if your PC 
crashes or you have network connectivity problems. 
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Choosing an Interface 
You can chose from among three interfaces to get information and handle transactions. The User Interface 
menu lets you make the choice.  

 

•  The Desktop interface allows you to purchase bandwidth through a series of user-selectable 
windows. Your agent is brought to your PC and bids on your behalf from there. On the desktop, 
monitoring features let you watch the Merkato auction in real time. 

•  The Express interface lets you get status information from—and send configuration information 
to—an agent in the Garage. The Express interface is at the top of the Portal page when you log in. 
The Express interface is considered advanced because the fields are less interactive, less 
annotated, and less graphical than the Java-based Merkato Desktop interface. Note that the 
Express interface does not support creation or cancellation of reservations. 

•  The Wizard walks you through the steps for setting up your Merkato agent to obtain bandwidth 
through the Spot market. The settings are automatically transferred to your agent. Changes made 
through the Wizard are applied to both the Desktop and Express agents. You can later change the 
settings from the agent interfaces, or return to the Wizard and make changes there. 

When you first log in, the Express interface appears in the browser window. 

We recommended that you start with the Wizard interface to make basic buying choices. When you 
become more advanced in your use of Merkato you can make further changes on the Desktop interface. 
The Desktop interface also gives you the most detailed status information. As you become more proficient 
with Merkato, you may want to use the Express interface to make quick configuration changes and status 
checks without downloading your agent to your PC. 
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Figure 13. The Wizard Window 

Using the Wizard 
The Wizard interface walks you through the steps to set up Merkato to obtain 
bandwidth. You can use the Wizard to set up bidding on the Express interface. 

If you launch the Wizard from the Merkato Portal it will configure an agent in 
the Garage.  

If you start the Desktop interface and launch the Wizard, it configures the 
Desktop interface. (This configuration is applied to your Garage agent profile 
when you save or upload.) 

To access the Wizard from the Merkato Portal, select it from the Portal user 
interface menu, as shown below. 

 

The Wizard window appears (Figure 13). The Wizard takes you step-by-step 
through configuration of your Merkato Spot market agent. It provides detailed 
help on each page. You can activate the Help display by clicking the check box 
at the bottom of the screen, between the Next and Apply buttons). 

When you reach the final screen of the Wizard, you have done the following: 

•  specified the bandwidth resource which you would like to obtain 

•  selected units for display of currency, bandwidth quantity, and time 

•  set a minimum amount of bandwidth that you would like to obtain 

•  set a maximum amount of bandwidth that you would like to obtain 

•  set a budget that you do not want to exceed when bidding for bandwidth between your minimum 
and maximum thresholds 
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Figure 14. The Apply Settings Menu in the Wizard 

Figure 15. The Express Agent interface With Values 
Configured 

The final Wizard screen lets you confirm your choices and apply them to your agent. It 
gives you the option to begin bidding after it applies configuration changes are applied 
to your agent. 

To begin obtaining bandwidth in the Spot market immediately, do the following: 

1. Select Apply Settings and Start Bidding from the pull-down list. (See Figure 14.) 

2. Click Apply at the bottom of the screen. 

If you launched the Wizard from the Merkato Desktop, the Desktop agent is active and 
bidding. 

If you launched the Wizard from the Merkato Portal: 

1. In the confirmation window, click Yes to indicate that you want to quit the 
Wizard and apply the settings. 

2. Select Express from the user interface selection pull-down menu. 

  
The configuration you set using the Wizard appears in the Express interface, shown in 
Figure 15. 

The Status selection in the Express interface indicates that the agent is active, showing that 
the agent is currently bidding. 
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Using the Desktop Agent 
You can use a Desktop agent to bid from your PC. You can also use the desktop to conveniently make 
setting changes, and then upload your configured Desktop agent and bid from a Garage. (See “Note: 
Bidding From the Garage or From the Desktop” on page 10.) 

For a complete description of fields in the Desktop agent, see Merkato Buyers’ Reference Manual, 
“Desktop Interface.” 

Downloading the Desktop Agent 
To bid using the Desktop agent, do the following: 

1. From the Merkato portal, select Desktop from the user interface menu and click select. 

 

If Java 1.4.1 is not installed on your PC, Merkato will prompt you to download it. 
The Desktop window appears, as shown in Figure 16. 

2. If the Agent Download window is not available, from the File pull-down menu, select Download 
Agent (Figure 17). The Agent Download login box appears (Figure 18). 

3. In the Agent Download window, enter the username and password. 

By default, these are the same as the username and password you used to access the Desktop 
interface from the initial login; the fields are populated with this information. You may specify 
another valid username and password to download another agent. 

 

Figure 16. The Merkato Desktop 

Figure 18. The Agent Download 
Login Box 

Figure 17. The File Pull-Down Menu 
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4. Select a Garage from the pull-down menu (Figure 19). Make sure the Garage you select is the one 
that contains the desired Spot market agent. 
 
You may have a separate Garage for your Reservations agent, as well as Garages for multiple Spot 
market agents (if you are allowed to purchase bandwidth from multiple markets simultaneously). 
(See “Note: Bidding From the Garage or From the Desktop” on page 10.) 

5. Click Download. When the agent finishes downloading it appears on the Merkato desktop, as 
shown in Figure 20. 

 Figure 19. Garage Selection on 
the Agent Download Login Box 
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Figure 20.The Merkato Desktop Agent 

Arranging Sub-Windows within the Agent Window 
The agent window consists of smaller sub-windows, each of which can be displayed or 
closed as you wish. 

Each time a window is selected for viewing it appears beneath the previously activated 
window. To close a window, click the close-box tab at the upper right hand corner of the 
window ( ). The window closes and the other windows move up to fill in the spot it 
occupied. 

To resize the agent window to exactly match the windows displayed, click the Pack 

icon (  second from right) or select Pack from the View pull-down menu. 

Note:  To arrange agent windows on the Merkato desktop, see Merkato Buyers’ Reference 
Manual, “Arranging Agent Windows.” 

 
Figure 21. The Desktop Agent With Stacking Disabled 
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Select Bidding Units 
In the Units fields, you can make changes to money, time, or bandwidth units. Changing units doesn’t 
change your bid—it converts the displayed values to the ones you choose. 

From the Selection pull-down menu, select Units. The Units box appears (though you may have to expand 
the agent box to see it). (See Figure 22.) 

Use the pull-down menus in the Currency, Quantity, and Time fields to pick the units you want to see in 
the other desktop agent windows. 

For details, see “Units Conversion Chart” on page 34. 

Figure 22. The Units Window 



 

 InvisibleHand Networks, Inc Buyer’s User Manual 18 

Figure 23. Selecting a Valuation 

Select a Valuation 
Your valuation settings indicate how much you are willing to pay for a range of desired bandwidth. In the 
course of an auction, your agent uses this valuation information, together with the market price, to 
determine how much to bid and how much bandwidth to ask for, in response to changing market 
conditions. 

For a description of the valuation methods, see Merkato Buyers’ Reference Manual, “Valuation 
Overview.” 

1. From the Valuation pull-down menu, select a valuation method. (See Figure 23.) 

2. Create your valuation by filling in the fields. The fields are different depending on which 
valuation method you select. For an automated approach to setting quantities see “Using Traffic 
Based Bidding” on page 20 and “Using Quick Response Bidding” on page 22. 

3. Select Current Valuation to activate the valuation. 

4. Click Apply. (The Apply button is only available after you make a change.) 

Changes to valuations only affect bidding if that particular valuation is active indicated by the Current 
Valuation radio button at the top of the window and the green arrow in the pull-down menu list. If a 
valuation is not active, the changes are stored until you activate that valuation. 
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Figure 24. Traffic-Based Bidding Measurements 

Traffic-Based Bidding 
If you enable the Traffic-based tab in the valuation window, your agent changes its 
maximum quantity by checking the usage at intervals. The agent measures the amount of 
traffic at intervals you set (in the Time Window field). The agent bids for that amount of 
bandwidth, plus a quantity margin you set (in the Qty Margin field). The quantity margin 
can prevent your agent’s maximum bid quantity from reaching zero at times of no 
traffic. 

The diagrams in Figure 24 and Figure 25 show the relationship between the settings. 

 

Figure 25: The Traffic-Based Bidding Time Window 
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Using Traffic Based Bidding 
Each valuation window has a Traffic-based tab (shown in Figure 26), and each serves the same function. 

To use Traffic-based valuation, do the following. 

1. In the Meas. Window field, enter the time interval at which you want your agent to adjust its 
bidding based on traffic volume. (You may want to change the units shown in the field to a shorter 
period. The smallest interval you can select is six minutes.) 

2. In the Qty Margin field, enter the amount you want the agent to add to the measured traffic in 
calculating the requested quantity. This amount should be the average amount of your traffic 
increase, to allow for occasional spikes. 

3. Check the Active check box. 

4. Click Apply to active the changes you made to your agent. 

Raising the quantity your agent bids for will increase your allocation if your bid is in accordance with 
market rates. If you find you agent consistantly being out-bid, you should raise the value or budget in your 
valuation. 

Figure 26. The Traffic-Based Valuation Tab 
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Figure 27. Quick Response Bidding Over Time 

Quick Response Bidding 
Traffic-based valuation makes the Merkato Buyer agent respond to changes in network traffic. As traffic 
fluctuates, the Buyer agent reacts by changing the quantity of bandwidth it bids for. This change is 
incremental; the agent bids for the measured traffic (plus the quantity margin) for the duration of the Time 
Window. 

However, traffic may increase dramatically during that time. 

The Quick Response feature is useful for buyers who 
know, when traffic reaches a certain threshold, that the 
agent should increase its bidding quantity to a specific 
peak. This is the peak traffic the buyer expects. 

The Quick Response feature works with Traffic-based 
bidding to make Merkato bidding jump to a certain 
quantity. It works only when Traffic-based bidding is 
activated. 

Example of Quick Response Bidding 
As shown in Figure 27, Traffic-based bidding tracks 
usage and causes the agent to bid at this rate (plus the 
quantity margin). Then traffic exceeds the traffic 
threshold. Immediately, the agent begins bidding for the 
estimated peak amount (plus the quantity margin). The 
agent continues bidding at this rate. Every five minutes 
Merkato examines the usage rate for the duration of the 
traffic window. When all traffic in the traffic window 
falls below the threshold, the agent resumes Traffic-based 
bidding. 

Formatted: Heading 4
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Figure 28. The Quick Response Valuation Tab

Using Quick Response Bidding 
When Quick Response is enabled (as well as Traffic-based valuation), your agent reacts to bursts of traffic 
by starting immediately to bid at the Est. Peak Traffic level (plus the Qty. Margin). 

An agent with Quick Response enabled uses the values you place in two fields (see Figure 28): 

Traffic Threshold—The quantity of traffic that triggers the Quick Response. When Merkato detects this 
level of traffic it changes the amount of bandwidth that the agent bids for. 

Estimated Peak Traffic —When Quick Response is triggered, the amount the agent bids for is the 
amount you enter in the Est. Peak Traffic field, plus the quantity margin. 

Note:  Est. Peak Traffic should not exceed the amount in the valuation window’s Quantity field. The agent will 
not bid for an amount larger than is entered in the Quantity field. 

Active check box Checking this box enables Quick Response bidding on your agent. 

Apply Clicking Apply makes the numbers entered in the fields of the Quick Response tab active.  

The signals mean the following: 

Not Ready: Quick Response Valuation has been engaged, but there has not yet been a Time Window 
during which all traffic is below the Traffic Threshold. If a Time Window ends with no traffic above the 
threshold, the signal returns to Ready. 

Ready: Quick Response is active, but no traffic above the Traffic Threshold been detected. 

Engaged: Merkato has detected traffic above the Traffic Threshold and Quick Response is active. This 
state remains for at least the duration of the Time Window. 

There is no guarantee of getting an amount of bandwidth equal to your estimated peak traffic. There are 
two reasons for this: 

•  The Estimated Peak Traffic may exceed the amount the Seller is offering. 

•  The Estimated Peak Traffic may exceed your budget (for instance, if demand is higher than you 
anticipated and your budget does not cover the cost). Your Agent will still try to acquire as much 
bandwidth as it can. 
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Figure 29. The Automatic Strategy Window 

Select a Strategy 
You can bid using an automatic strategy or a manual strategy.  

An automatic strategy changes your bid continually according to market conditions and your valuation 
settings.  

A manual strategy lets you make single bids at a set quantity and price. 

(For a complete description of Merkato strategies, see Merkato Buyers’ Reference Manual, “Strategy 
Overview.”) 

Note: If the quantity (Mbps, for example) or time units (month, for example) displayed do not suit your needs, 
you can change the units. Select Units from the Selection pull-down menu. The Units box lets you use 
Kbps, Mbps, or Gbps, as well as minutes, hours, days, and months. (See “Select Bidding Units” on page 
17.) 

Automatic Strategy 
From the Strategy pull-down menu, select Auto Strategy.  

The Auto Strategy window appears. (See Figure 29.) 

With Automatic Strategy selected your agent starts bidding for you immediately and 
does not stop until you disable it. 

The Auto Strategy window lets you see your bids as they are submitted. With Auto 
Strategy active, your agent bids, if its valuation allows it, every time the market price 
exceeds its last submitted bid. (Since the market price is determined by the price 
offered by the lowest successful bidder, a bid under this price does not receive an 
allocation.) 

1. Select the Current Strategy radio button. 

2. Enter the amount of bandwidth you want to bid for in the left field (quantity). 

3. Enter the maximum you are willing to spend in the right field (cost). 
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Figure 30. The Manual Strategy Window 

Manual Strategy 

From the Strategy pull-down menu, select Manual Strategy. The window shown in 
Figure 30 appears. The displayed quantity and unit price are those of your last bid. 

1. Select the Current Strategy radio button. 

2. Enter the amount of bandwidth you want to bid for in the left field (quantity). 

3. Enter the maximum you can spend in the right field (cost). 

When you are connected to the Garage and ready to bid, click Bid. This sends your 
bid to the auction. Note that this is a one-time event. The submitted bid is not carried 
over to the next auction round. If you wish to place a single take-it-or-leave-it bid 
each auction round, use the Linear valuation with the Automatic strategy. 

Connecting and Starting Your Agent 
The three icons at the upper left of the icon bar are, (from left to right) “Connect,” 
“Start,” and “Stop.” 

 

When you first download an agent it may not be connected to the auction. Your agent cannot bid when it is 
disconnected, although you can set its configuration. When the connect symbol on the icon bar (on the far 
left) is un-depressed and un-colored the agent is disconnected. 

When you connect to the auction, until you click the Start icon, you may observe the auction but you are 
not participating in it. 

When you want to start bidding click the Start icon (  second from left on the icon bar). Bidding starts 
immediately with the current settings. 

To stop bidding, click the Stop icon (  third from left on icon bar). Your agent stops bidding and is 
disconnected. To begin viewing the auction again you must connect again. 
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Figure 31. The Allocation Window 

Viewing Your Allocations 
The Allocation window (Figure 31) provides information about the quantity of bandwidth bought 
and the price paid for that bandwidth at the close of the last auction. It also monitors the time left 
in the current auction. 

To view the Allocation window, select Allocation from the Status pull-down menu. 

During an auction, the Time Left field counts down the seconds left in the auction. The auction 
does not close until all agents have stopped bidding. 

When the auction ends and an allocation is made to your agent, its quantity and unit price appear 
in the left-hand side of the Allocation window. It remains displayed until you get another 
allocation. 

If You Fail To Get an Allocation 
If market conditions are such that you get no allocation (or choose not to bid), your traffic still has 
bandwidth available to it. The data streams of agents that do not bid (or do not win any allocation) 
are generally funneled through a single, shared amount of permanently allocated bandwidth. This 
bandwidth is shared by all buyers who fail to get allocations. Ask your Merkato administrator how 
much bandwidth is allocated to this “best effort queue” so that you can make the best decision of 
when to stop bidding on the low end (see Budget Valuation with Limits). 
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Viewing Auction History and Current Data 
In addition to the Allocation window, Merkato provides a variety of other tools to let you view past and 
current auction data. These include the following: 

Auction Graph—Indicates the state of the Merkato auction in progress, for all agents actively bidding. 
Colors and shapes on the graph indicate each bidder’s last bid, your previous allocation, your proposed 
allocation, a graph of your valuation, and the activity of other bidders. 

Auction Table—Shows a quantitative, real-time view of the auction in progress. 

News Window—Shows the real-time status of your agent and the capacity and price currently offered in 
the market (if the agent is connected). 

You can use this information to optimize your bidding strategy in relation to other bidders in the auction. 

See the Merkato Buyers’ Reference Manual for details about these tools. 
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Figure 32. The Upload Confirmation Box 

Letting Your Agent Bid Without You (Uploading) 
You can set your agent to bid continually for you. You don’t need to monitor it and you don’t need to run 
it on your PC. You can upload it to the Garage, where it remains active and continues to bid on your 
behalf. This ensures that you continually get the bandwidth you need at the best price, based on the 
valuation you set when you configure the agent. Simply upload your agent to the Garage. You can 
continue to monitor it via the Express interface on the Portal, but if you close the desktop or shut off your 
PC, the agent continues to function as you have set it. 

To upload and exit, do the following: 

Click the up-arrow icon ( ). The confirmation message indicates the Garage where your agent will be 
placed. (See Figure 32.) 

When the confirmation box appears (Figure 32), click OK.   

The agent window closes but the Merkato desktop window remains. 
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Figure 33. The Save Configuration 
Confirmation Box 

Saving Your Configuration 
You may want to save the settings you made on the Desktop agent, to your Garage agent profile, without 
exiting from the Desktop agent. We recommend this to ensure that if your PC freezes or reboots, your 
configuration changes are not lost. 

If you want to save the way your agent is configured, but not transfer your agent to the Garage, do the 
following: 

1. From the File menu, select Save Configuration: 

 

A confirmation box appears (Figure 33), showing which Garage your configuration will be saved 
to. (If multiple Garages are available, they will appear in a pull-down list.) 

2. Make sure the Garage listed is the one you want to save to (generally the Garage you downloaded 
the agent from), and click OK. 
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Exiting the Merkato Desktop 
To exit Merkato, click the close-box tab at the upper right hand corner of the window ( ), or select Exit 
Merkato from the File pull-down menu. 

You can leave the Portal page in the browser open to monitor your agent status (via the Express agent), or 
click Logout in the list on the left side of the window. 
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Figure 34: The Merkato Portal Showing the Express Agent 

Using the Express Agent 
The Express interface is an HTML version of the Desktop interface, 
with some significant differences: 

•  It leaves your agent in the Garage and controls it remotely. 
(See “Note: Bidding From the Garage or From the Desktop” on 
page 10.) 

•  The screen is not updated in real time. You must click Refresh 
to update information in status displays. 

•  You may not create or cancel reservations through this interface. 
Nor can you submit manual bids or make changes to Traffic-
based valuation settings. (Existing settings made in these areas 
through the Desktop interface are not affected by using the 
Express interface to change other settings.) 

The Express interface is meant to support advanced users who know 
what the fields mean and wish to have a quick way to check agent status 
or make configuration changes. 

(See Merkato Buyers’ Reference Manual, “Express Agent.”) 

The Express agent is the first screen you see when you log in on the 
Merkato Portal. 

When you first log in, the window looks like the one in Figure 34. 
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Valuation and Strategy 
You must configure the Express agent to bid using an automatic strategy. (Manual is available but not 
supported.) An automatic strategy changes your bid continually according to your valuation settings and 
market conditions. It bases the bid on the market price, your valuation parameters, and the amount it is 
informed it would receive if no more bids were submitted (and this auction round closed). 

Use of a manual strategy (submitting each bid manually) is not supported through the Express interface, 
but this strategy setting will be indicated if previously configured (and uploaded) via the Desktop 
interface. 

(See Merkato Buyers’ Reference Manual, “Strategy Overview.”) 

You must also configure the Express agent with a valuation method. 

Your valuation settings indicate the maximum you are willing to pay for a range of bandwidth. In the 
course of an auction, your agent uses this valuation information to determine whether to bid, how much 
bandwidth to ask for, and how much to offer, in response to changing market conditions. 

In the Express interface, you can view and change settings for inactive or the active valuation. You do this 
by making a selection under the “Valuation View” pull-down menu. The valuation parameters 
automatically change to reflect the selected valuation.  To make the new valuation active, click Apply. 
The “Current Valuation” display changes to the valuation currently being viewed, and the agent begins 
bidding using the new valuation profile and settings. 

(See Merkato Buyers’ Reference Manual, “Valuations Overview.”) 

Controlling the Express Agent 
The Active and Inactive radio buttons at the top of the window control whether the Express agent is 
running. 

The Refresh and Apply buttons at the bottom of the window control communication with your agent: 

•  Refresh updates the status fields in the windows without sending configuration changes to the 
agent. All values saved the last time changes were applied are restored. 

•  Apply sends configuration changes to the Agent. 

For a complete description of fields in the Express Agent, see Merkato Buyers’ Reference Manual, 
“Express Agent.” 
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Figure 35. The Express Agent 

Bidding From the Express Agent 
To bid for bandwidth from the Express agent, follow these steps: 

1. Make sure the Spot market is selected in the Resource field. 

2. Select Auto Strategy in the Strategy field. 

3. Select a valuation in the Valuation View field. (For a description of the methods of valuation, 
see Merkato Buyers’ Reference Manual, “Valuation Overview.”)  

4. In the Units fields, you can make changes to money, time, or bandwidth units. Changing units 
doesn’t change your bid—it changes the display to show the units you choose. 

5. In the Min Qty field, enter the Minimum bandwidth you want to buy. (A line through this field 
means that no entry is necessary.) 

6. In the Max Qty field, enter the maximum bandwidth you want to buy. (A line through this 
field means that no entry is necessary.) If the maximum quantity is the all the seller is selling, 
check the Max Qty = All check box. 

7. In the Budget/Max Value field, enter the appropriate currency per unit/time value for the 
valuation you selected. For budget-based valuations, this is the maximum amount of money 
you are willing to spend on the acceptable range of bandwidth you want to buy. For other 
valuations, this value is related to the maximum you are willing to spend, but does not directly 
correspond to it. The Merkato Buyers’ Reference Manual, “Valuation Overview” explains how 
to configure these details for each valuation.) 

8. When you are satisfied with all entries, click Apply. The “Current Valuation” display changes to 
the Valuation View you configured. 

9. If you want to begin bidding now, click the active radio button in the Status area. 

10. Click Apply to begin bidding. A Bid field appears in the display, indicating the amount of your 
current bid. Click Refresh to update this display at any time. 

11. In five to ten minutes (depending on the length of the auction), click Refresh again. The 
Allocation field appears. It displays the bandwidth you have won, and its cost, in the completed 
auction. Click Refresh to update this display. 

Figure 35 shows the Express interface, as it appears after you complete these procedures. 
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Figure 36. The Recent Allocations Table 

Viewing Historical Information 
The Recent Allocations table is part of the Merkato Portal. It 
appears under the Express Agent. (See Figure 36.) 

The Recent Allocations table shows bandwidth allocated to the 
current loggedin user and the amount charged for this bandwidth. 
Allocations are shown in order, most recent at the top (sorted by 
End Time). Each row corresponds to a single reservation (for 
Reservation market resources), and for an hourly roll-up of 
auction results (for Spot market resources). The Allocation Table 
indicates that Merkato auctions have been providing the desired 
results. 

For a full description of Express agent fields, see Merkato Buyers’ 
Reference Manual, “Express Agent.” 
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Appendix 

This section contains information you may find useful as you configure your agent. 

Units Conversion Chart 
If you find it more convenient to think of bandwidth in terms of transfer time for files of various sizes, 
which are expressed on bytes rather than bits, the following chart may be helpful.   

GigaBytes/month 
(GB/mo) 

MegaBytes/month 
(MB/mo) 

Megabits/sec 
(Mbps) 

Kilobits/sec 
(Kbps) 

Telco Standard 

150 150,000 0.5 463   

166 166,000 0.5 512 512K 

250 250,000 0.8 772   

500.3 500,300 1.5 1,544 T-1 

1,000 1,000,000 3.1 3,086   

5,000 5,000,000 15.4 15,432   

10,000 10,000,000 30.9 30,864   

14,495 14,494,500 44.7 44,736 T-3 

15,000 15,000,000 46.3 46,296   

16,796 16,796,000 51.8 51,840 OC-1 

20,000 20,000,000 61.7 61,728   

25,000 25,000,000 77.2 77,160   

30,000 30,000,000 92.6 92,593   

40,000 40,000,000 123.5 123,457   

50,389 50,388,500 155.5 155,520 OC-3 

75,000 75,000,000 231.5 231,481   

100,000 100,000,000 308.6 308,642   
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Valuation Summary Chart 
 Linear Square 

Root 
Budget Budget 

With 
Limits 

Logarithmic Parabolic 

Bandwidth 
Quantity 

Flexible, 
depending on 
availability 

Fluctuates 
with 
market 

Fluctuates 
with 
market 

Uses 
minimum 
and 
maximum 
range 

Fluctuates 
with market 

Fluctuates 
with market 

Price Fixed – price 
per unit 

Fluctuates 
with 
market 

Fluctuates 
with 
market 

Fluctuates 
with 
market 

Fluctuates 
with market 

Fluctuates 
with market 

Cost Proportional 
to quantity 
received 

Decreases 
with 
decreasing 
quantity 

Constant 
regardless 
of quantity 
received 

Constant if 
quantity 
received is 
within 
range 

Peaks at 
middle of 
quantity 
range 

Peaks at 
middle of 
quantity 
range 

Agent 
Actions 

Agent bids at 
constant unit 
price 
regardless of 
quantity. 

Agent 
increases 
bandwidth 
request as 
market 
price 
drops, and 
decrease 
request as 
price 
increases. 

Agent 
purchases 
all 
bandwidth 
possible 
for $XX. 

Agent will 
purchase 
bandwidth 
only up to 
X amount, 
even if 
price 
drops.   

Agent bids 
aggressively 
at the mid-
point of a 
quantity 
range. Use if 
you want a 
certain 
bandwidth 
amount, but 
will take 
more at 
lower cost.  

Agent bids 
aggressively 
at the mid-
point of a 
quantity 
range. Use if 
you want a 
certain 
bandwidth 
amount, but 
will take 
more at 
lower cost.  
Bids less 
aggressively 
than the Log 
valuation at 
lower 
amounts of 
bandwidth. 
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Glossary 

agent: The program that interacts with the rest of Merkato on behalf of buyers and sellers. Buyers can 
acquire bandwidth by configuring their agents to offer the price they are willing to pay for a range of 
available quantity, or use their agent to request a quote for a fixed-price bandwidth reservation. Sellers 
configure their agents with a quantity of bandwidth for sale and a minimum price they are willing to 
accept for that quantity.  

allocation: An amount of bandwidth available for your use. Depending on the type of service being 
offered through Merkato, this can represent the maximum bandwidth available to you or a minimum 
guarantee of bandwidth available to you. 

Alloc Price: Shown in the Allocation History graph, on the desktop, for a Buyer agent in the Spot market. 
The price paid for bandwidth, in, for example, dollars-per-month per Mbps unit (the units are 
configurable). 

Alloc Quantity: Shown in the Allocation History graph, on the desktop, for a Buyer agent in the Spot 
market.The amount of bandwidth allocatated to the Buyer. 

bandwidth: The amount of data transmitted or received per unit of time. When we refer to acquiring or 
selling bandwidth, we mean the amount of information that can be sent over a connection at one time, at 
the allowed speed, without packet loss or excessive delay. Bandwidth is measured in bits-per-second. 

bumping: Bumping occurs when a user logs in using the ID and password of an active agent. The user 
who is logging-in sees a message that an agent with this login ID is already active. If the new user 
procedes, the old user is disconnected. The agent uses the saved configuration of the agent, not necessarily 
the configuration of the previously active agent. 

Buyer agent: The program that interacts with the rest of Merkato on behalf of buyers. Buyers can acquire 
bandwidth by configuring their agents with the price they are willing to pay for a range of bandwidth (on 
the Spot market), or with a time-frame and desired quantity (on the Reservation market). In a Merkato 
auction, Buyer agents signal what they are willing to pay for bandwidth in the form of bids, consisting of a 
unit price and a quantity. 

capacity: In the Merkato interface, the term capacity refers to the total amount of bandwidth available 
from the Seller. 

data transfer rate: The speed at which data is transferred from one port to another. See Kbps, Mbps, and 
Gbps. 
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Desktop agent: The Merkato application for buyers or sellers that runs on a Windows PC. Merkato 
desktop agents bid for bandwidth from the user’s PC using a Java-based application. Alternatively, 
Merkato agents can run as an application on a server, called the “Garage.” Users can interact with these 
remote agents through an HTML browser interface. 

Express agent: The Merkato HTTP application for buyers or sellers that configures and obtains status 
from Merkato agents running from a remote location. Accessing the agent in this way is an alternative to 
bringing the agent to the user’s desktop and using the Java-based interface. The Express agent is 
accessible through the Portal. 

floor price: The lowest price the seller will accept for bandwidth. The seller can establish the floor price 
through the Seller agent.  

Garage: A feature on the Merkato server where player (Buyer and Seller) agent configuration profiles 
reside. The gararge stores agent configurations whether the players are active or not. 

Gbps: One of the ways of expressing units of bandwidth; Gigabits-per-second (1,000,000,000 bits-per-
second). 

Java: A programming language, useful for internet and networking applications. The environment used 
for the Merkato Desktop Interface.  

Kbps: One of the ways of expressing units of bandwidth–kilobits-per-second (1,000 bits-per-second). 

market price: The price for something that buyers and sellers agree on. Merkato establishes a market 
price for bandwidth during each spot market auction round. There is a fixed amount for sale, so as demand 
increases, prices rise. Ordinarily, the market price is reached when the cumulative demand of all the 
buyers is equal to the amount of bandwidth being offered by the seller. 

Max Qty Requested The maximum quantity requested display, shown in the Traffic-based valuation 
tab. The Merkato agent adds the measured traffic to the Quantity Margin to create this number. This is the 
value that is carried forward into the main valuation calculation. It is called the “Maximum Quantity 
Requested” because Merkato compares to the “Max Qty” value in the main valuation window. Merkato 
uses whichever value is smaller as the basis for the maximum quantity requested. (In other words, traffic-
based settings can only reduce the amount of bandwidth you ask for relative to the main valuation settings, 
they never increase it.) 

Mbps: One of the ways of expressing units of bandwidth–Megabits-per-second (1,000,000 bits-per-
second). 
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Meas. Traffic: The measured traffic display, shown in the Traffic-based valuation tab. The peak amount 
of traffic the agent has measured at the interval set in the Meas. Window field. Merkato uses this peak 
five-minute interval as the basis for the “Max Quantity Requested” calculation. 

Merkato desktop: The Merkato desktop is the first window that appears when the user begins to bring the 
Merkato buyer or seller agent to their desktop. It lets users specify which Merkato agent or agents they 
want to download to the desktop. 

Merkato: InvisibleHand’s software platform, which dynamically prices, sells, and allocates IP bandwidth 
in real time. Merkato means “market” in Esperanto. 

Player: A buyer or seller in the Merkato auction. 

Portal: The main access point to all Merkato applications. It is an HTML-based interface accessible from 
a standard web browser. 

progressive second price auction: The unique market mechanism by which Merkato allocates bandwidth 
to potential buyers at an optimal market price. An auction is established, where each bid consists of a unit 
price and the quantity desired at that price. Bidders are ranked according to the unit price they offer. 
Bidders who get an allocation pay the unit price offered by the highest bidder who does not get an 
allocation. (This is the “second price” aspect of the auction.) Bidders who don’t get an allocation can re-
bid at a higher unit price, in an attempt to improve their ranking in the auction. (This is the “progressive” 
aspect of the auction.) An auction round closes when all bidders are either successful, based on their last 
bid, or cannot match the price offered by the current lowest successful bidder. 

PSP: See “progressive second price auction.” 

Qty Margin: The Quantity Margin, shown in the Traffic-based valuation tab. This is the amount of 
bandwidth the Buyer agent attempts to obtain above that of the recent measured peak. 

Reservation market agent: A buyer agent connected to the Reservation market. 

Reservation market: The Merkato market mechanism by which a specified quantity of bandwidth, for a 
specific duration, is sold for a firm price specified by the seller and agreed to by the buyer. This is an 
automated process based on a rate sheet that the seller establishes in advance. 

Resource agent: The program that manages the Merkato marketplaces, where bids are received and 
allocations issued (the Spot market) or where price quotes for reservations are generated and accepted 
quotes for reservations are processed. 

Seller agent: The program that interacts with the rest of Merkato on behalf of sellers. Sellers configure 
their agents with a quantity of bandwidth capacity for sale and a minimum price for that quantity. Buyer 
agents then express what they are willing to pay for bandwidth in the form of bids, consisting of a unit 
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price and a quantity. Currently, there is no seller agent for the Reservation market, but one will be 
supported in a future release. 

Spot market: The Merkato mechanism by which bandwidth is traded, in a progressive second price 
auction. An optimal fair market price is established and bandwidth is allocated to buyers, based on their 
bids relative to other buyers. 

Spot Market agent: A Buyer agent or Seller agent connected to a Spot market. There are also reservation 
agents (for buyers only). 

Time Window: The Measurement window, shown in the Traffic-based valuation tab. The agent 
continuously measures the amount of traffic you generate in five-minute increments. The Time window 
setting tells the agent, in minutes, how far back in time to look for the peak. 

Usage: Shown in the Allocation History graph, on the desktop, for a Buyer agent in the Spot market.The 
amount of traffic that Merkato has measured for the buyer. This measurement is used in Traffic-based and 
Quick Response bidding. 

valuation: The value a buyer or seller places on bandwidth. Setting a valuation is part of setting a 
purchasing strategy. Valuation settings within a buyer agent let buyers specify the amount they are willing 
to pay for varying amounts of bandwidth. This information is used by the agent to respond to changing 
market conditions during a Merkato progressive second price auction. 

Wizard: In Merkato, an automated series of inquiry screens that walks you through the process of 
creating and configuring a Spot market Buyer agent. 


